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Opening and closing files 

To open a file 
 
First, tell Word what you are doing. 

1. Click on the Office Button. 

2. Move the mouse straight down and click on the Open 
command. 

 

Now, tell Word where to look for your file. 

1. Click the drop down arrow to the right of the words Look in:. 

2. Move the mouse pointer down to the storage device indicated 
by your instructor and click. 

3. When the contents of the storage device appear, select the file 
or folder you want to open by clicking the icon beside its name. 
For practice today, open the document File 1.  

4. Press the Enter key on your keyboard or move the mouse 
pointer over to the Open button and click. 

 

To close a file and Microsoft 
Word 
 

1. Click on the Office Button. 
 
 
 
 
 
 
 

2. To close a file, move the mouse 
straight down and click on the 
Close command 

 

To close the Word program instead of just the document, move the mouse 
down and click on the Exit Word button. 

 

Opening and closing files 

 
 
 
 

 

 

You can also close Word by 
clicking on the X in the 
upper right corner of the 
window. 
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Navigation 

The insertion point 
 
The insertion point is a flashing vertical bar in your document that tells you 
where your text will go. You can move the insertion point by using the mouse or 
the keyboard. Remember to always look for the insertion point before you start 
typing.  
 
Using the scroll bar 
 
The scroll bar can be used to move through a document. To choose a specific 
location in the document, click and drag the scroll box to that location. 
 
By clicking in the lighter gray area above or below the scroll box, you can move 
through the document one screen at a time. 
 
The single up and down arrows on the scroll bar allow you to navigate through 
the document one line at a time. 
 
The double up and down arrows allow you to navigate through the document 
one page at a time. 
 

Using the keyboard 
 
You can use the scroll bars on the screen or the scroll wheel on your mouse to 
move through your document, or the following keyboard shortcuts. 

 
Tab - Moves the insertion point over to the next tab. 

Enter - Moves the insertion point down a line. 

Page Up - Moves you to the previous page. 

Page Down - Moves you to the next page. 

Home - Moves you to the beginning of the line. 

End - Moves you to the end of the line. 

Ctrl + Home - Moves you to the beginning of your document. 

Ctrl + End - Moves you to the end of your document. 

Arrow keys - Move you one character or one line in the direction 
of the arrow. 
 

Using the scroll wheel 
 
You can use the scroll wheel on your mouse to move through your document.  
 

 

Page 
Up/Down 

The Scroll Bar 

 Scroll Box 

Scroll Up Arrow 

Keyboard combos 

To use a combination shortcut, 
such as Ctrl + End, press and 
hold the Ctrl key while you tap 
the End key. 

Scroll Down  
Arrow 
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1. If Word is not already running, open Word according to your 
instructor’s directions. 

2. Open the file called File 2. 

3. Use the Scroll Down arrow on the scroll bar to move to the bottom of 
the document one line at a time. 

4. Now go back up to the top by pressing and holding down the Scroll 
Up arrow. 

5. Use the Scroll Box to move towards the bottom of the document. 

6. Try using the Next Page and Previous Page commands to move 
through the document. 

7. Use the scroll wheel on your mouse to move up and down the 
document. 

8. Use the keyboard shortcuts to move around the document. Try all four 
arrow keys, as well as Page Up, Page Down, End and Home.  

9. Use your mouse to reposition the flashing Insertion Point. 

10. Close File 2 using either one of the methods discussed in the handout. 
When asked if you want to save your changes, click on No. 

Exercise 1 
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  Creating a new document 

Click the Office Button and then Click on New. 

 

Entering text 

Type new text in at the flashing insertion point. Use the Enter key to start a 
new paragraph. Do not press the Enter key unless you want to start a 
new paragraph. When you are typing a lengthy paragraph, you do not need 
to press Enter just because you are getting close to the right side of the 
page. There is a function of Word called Word Wrap which automatically 
detects the margins and moves to the next line for you.  

 

Deleting individual characters 

Use the Backspace key to delete characters to the left of the insertion point. 

Use the Delete key to delete characters to the right of the insertion point. 

 

 

 

 

 

 

 

Saving 
To save your document, click the Save command on 
the Quick Access Toolbar. 

 

The first time you save a document, the 
Save As window will appear. Give your 
document a name and tell Word where 
you want to save the file. 

After the first save, the settings that you 
specified in the Save As window will 
apply every time you save a file. Word 
will not ask you for this information 
again. 

Creating and saving a simple 
document 

The Quick Access Toolbar 

 
Located in the upper left 
corner of the screen, to the 
right of the Microsoft Office 
Button, is an area called the 
Quick Access Toolbar. This 
area contains several of the 
most frequently used tools in 
Office applications—Save, 
Undo, Redo.  

 

The most wonderful 
buttons in the world! 

  Use the Undo command 
(loops to the left) on the 
Quick Access Toolbar to 
undo an action. 

  After you use the Undo 
command, the Redo 
command (loops to the 
right) will appear beside it 
on the Quick Access 
Toolbar. It redoes an 
action. 

Undo and Redo will work 
until you close your 
document. 

Use Delete to 
erase the “C” 

Use Backspace to 
erase the “W” Insertion point 

Redo Undo 
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1. If Word is already open on your computer, close it by clicking the top X 
in the upper right-hand corner. 

2. Open Word and create a new document. 

3. Type the short note below, making any changes you want. Remember: 
Your document will not have the same line length as this text. DO 
NOT press Enter at the end of each line to make it look like this! 
ONLY press Enter at the end of a paragraph. If you make any 
mistakes, leave them for now.  

 

 

 

 

 

 

 

 

 

 
 

4. Save the file to My Documents. Give it the file name Vacation. 

 

 

Exercise 2 

Dear Emily, 

Grab your swimsuit and 
sunglasses. We’re off to the 
beach. Take enough clothes 
to stay a while. We’re 
booked on a cruise ship 
headed for the Greek Isles! 

Don’t forget the suntan 
lotion. 

Love, Mom 
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Ribbons 

 
There is no way to delete 
or replace the Ribbon. 
However, you can  
minimize the Ribbon to 
make more space available 
on your screen. There are 
several ways to do this: 
 
1) To quickly minimize 

the Ribbon, double-
click the name of the 
active tab. Double-click 
a tab again to restore 
the Ribbon. 

2) Keyboard shortcut—
To minimize or restore 
the Ribbon, press 
CTRL+F1 

 

A Ribbon holds commands and icons in logical groups that relate to a type 
of activity. The Home Ribbon is always shown first, as it contains the 
commands you use the most often. 
 

What’s on the Ribbon 
 

There are three basic components to the Ribbon. 
 
1) Tabs sit across the top of the Ribbon. Each one represents core tasks 

you do in a given program. The term Tab is often used to refer to a 
Ribbon. 

 
2) Groups are sets of related commands, displayed on tabs. They pull 

together all the commands you're likely to need for a type of task, and 
they remain on display and readily available, giving you rich visual aids. 

 
3) Commands are arranged in groups. A command can be a button, a 

menu, or a box where you enter information. 

 
Ribbons are context sensitive. That means what you see varies depending 
on what you click in your document. For example, if you click on a table, 
you see a Ribbon with tools for working with tables. 
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  The Home Tab (Ribbon) is always shown first, and contains the commands 
you use the most often, including the text-formatting commands.  

Font Style – Specifies what the letters and numbers look 
like. For example: 

Arial 
Times New Roman 
Courier New 
Haettenschweiler 

 

Font Size – Specifies how large characters are. For example: 
Font size = 8 

Font size = 12 

Font size = 16 

Font size = 20 
Grow and Shrink Font – You can also use the Grow and Shrink Font 
commands to adjust font size. The command with a big A enlarges text; 
the command with a little A reduces font size. These commands use the 
same increments that are in the Font Size tool. 

Bold – Makes text darker/heavier     

Italic – Makes text lighter, tilted 

Underline – Underlines the text 

 

Font Color – Changes the color of text 
 

The Home Tab 

Explore the tools on the 
Home Tab by opening 
File 4 and following the 
instructions. 

 
Selecting text 
Before you can change the 
look of your text, you must 
first select (highlight) the text 
you want to change. There 
are several ways to do this. 
  Click in front of the first 

letter of the text you 
want to change. Hold 
down the mouse button 
and “drag” to the last 
letter of the text you 
want to select. 

or  
  Click in front of the first 

letter of the text you 
want to change. Move 
your cursor to just after 
the last letter of the text. 
Hold down the Ctrl key 
while you use the regular 
mouse button to click 
(Ctrl + Click). 

If you want to make changes 
to all of the text in a 
document, hold down the 
Ctrl key while you tap the A 
key (Ctrl + A). 

 Align Left Text in the paragraph aligns at the left margin, and the right 
margin is uneven. Align Left is the default setting in Word. 

 Center Center alignment aligns text in the paragraph so that it is 
centered between the left and right margins. 

 Align Right Text in the paragraph aligns at the right margin, and the left 
margin is uneven. The opposite of Align Left. 

 Justify The Justify alignment option adds additional space between 
words so that both the left and right margins are even. Justify 
is often used when formatting newspaper-style columns. 
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Click the Review tab, then the Spelling and Grammar command.  

The Spelling and Grammar check highlights what Word believes to be spelling 
or grammatical errors. The top box shows the 
problem as it appears in your document. In the 
bottom box, Word suggests alternate spellings or 
ways you could fix the grammatical error. 

To use one of the suggestions shown in the bottom 
of the spell check window, click the one you want 
and click the Change button.  

To skip the error and continue checking the document, click Ignore Once.  

To tell Word that the word is spelled correctly and is used throughout this 
document, click Ignore All. To add a word to the dictionary, so that Word will 
know it is spelled correctly in any document you create, click Add. 

(Note: Even before you click the Spelling & Grammar command, possible 
errors are highlighted in your document. Potential misspellings are underlined 
with a red wavy line. Potential grammatical mistakes are underlines with a green 
wavy line. Don’t worry, these lines will not print!) 

 

Using spell check  

To get practice using spell 
check, open File 7 and 
follow the instructions. 
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Exercise 3 

 

1. Open the file that you previously created and called Vacation. 

2. Select all the text in the document 

3. Modify the text so that: 

  The font size is 16. 

  The font style is Maiandra GD. 

  The font color is a shade of blue. 

  The text is bold. 

4. Underline the words “Greek Isles.” 

5. Save the changes you just made to this file. 

Dear Emily, 
 
Grab your swimsuit and 
sunglasses. We’re off to the 
beach. Take enough clothes 
to stay a while. We’re 
booked on a cruise ship 
headed for the Greek Isles! 
 
Don’t forget the suntan 
lotion. 
 
Love, Mom 
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To add a picture to your document: 
 

1. Click the Insert tab to bring up the 
Insert ribbon.  

2. Click the Clip Art icon. 

3. Everything else is done in the task 
pane. In the “Search for” box, type a 
one word description of what you want a picture of.   

4. Click Go. Your results will appear in the bottom of the task pane. 

5. If you want to see a picture in more detail, move your mouse cursor over 
it but do not click. You will see a small bar with a down-ward pointing 
triangle on it. Click the triangle, then choose Preview/Properties. After 
viewing the image, close the preview. 

6. Click the thumbnail of the picture you want to insert. 

7. Wait a few seconds. Your picture will appear in your document. 

Word doesn’t give you a lot of initial control over where the picture goes or what 
size it is. It is usually easier to resize it first. Move your cursor to the white circle 
in any of the corners of the picture until you see a double-headed diagonal 
arrow. Once you see the arrow, click and hold the mouse button down while you 
move the mouse to resize the image. (Away from the center of the picture will 
make it bigger; toward the center will make it smaller.) 

Before you can move the picture, you need to change its Text Wrapping. On the 
Picture Tools Format ribbon, which appears when you click a picture, in the 
Arrange group, find the Text Wrapping command. Click it, and from the drop-
down menu select Square or Tight. 

By the way, the green circle above you picture lets you tilt it. Put your cursor 
over it, and when you see the circular arrow, experiment with moving your 
cursor in various directions. 

Using pictures  

To get practice working 
with pictures, open File 6 
and follow the instructions. 

The Clip Art Task Pane 
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Print preview 
Always use Print Preview to see how your document will look when it is 
printed. That way there are no surprises and no extra pages. 

To access Print Preview, click the Office Button to see the menu. Click the 
Print command. Then choose Print Preview from the “Preview and print the 
document window.” 

 
 
 
 
 
 
 
 
 
 

Scroll through the pages of your document (if there is more than one page) 
using either your mouse’s scroll wheel or the Next Page and Previous Page 
buttons in the Preview group on the Print Preview ribbon.  

Print your document using the Print command on the Print Preview ribbon, or 
click the Close Print Preview command. 

 

Printing 
To print a document without using Print Preview, on the Office Button Menu, 
select the Print command. 

Printing your document 

Printing tips 

 

Remember, at the library 
each black and white page 
you print costs 10¢ and each 
color page is $1. 
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1. Open the file that you previously created and named Vacation. 

2. Insert a picture that relates to the letter. 

3. Run spell check, and proofread your document to see if it missed 
anything. 

4. Save your changes. 

5. Use Print Preview to see how your document would look when printed. 

6. Go through the steps for printing your document. Note: Because we 
are logged in for a class, you may not be able to print your finished 
document. 

Practice exercise 4 
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Final project 

1. Type the announcement shown below (with mistakes). 

2. Save the document and 
give it the name 
Computer Meeting. 

3. Spell check your 
document. 

4. Select the document 
and change the font 
style to one of your 
choice. 

5. Select “The Computer 
Club,” make it bold, 
and change the font 
size to 28. 

6. Select line two, change 
the font size to 18, and 
make it italic. 

7. Select line three, make 
it bold, and change the 
font size to 36. 

8. Insert a picture below 
line three. 

9. Select the entire document, center the text, and change the 
text color to one of your choice. 

10. Save the changes. 

11. Print Preview your document. 

 
 
The Computer Club 
 
Annunces its 
 
MONTHLY MEETING 
 
 
This month’s meeting is schiduled for 
Wednesday, July 23rd. from 3:00 pm untel 6:00 
pm in Southminster Hall. 
 
Our guest speaker for the event, Bill Gates of 
Microsoft Corporation, will address the issu of 
monopolies in the technulogy industry.   
 
Refreshments will be served beginning at 3:00.  
Our speeker will begin at 4:00. 
 
For further information, call 555-1234. 

Your finished product 
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